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2.5 Introduction to Word Processing 

2.5.1 Definition of terms 

 Word processing - This is the process of manipulating text, characters, words, and sentences 

in such a manners as to make the final document free of errors and attractive to look at. 

 Word processor - application software that enables the user to create, save, edit, format and 

print text-rich documents. 

 Examples of common word processors are: 

a) Microsoft Word 2010 

b) Corel WordPerfect 

c) Lotus Word Pro 

d) Word Star 

e) AppleWorks for Macintosh. 

 Advantages of Electronic Word Processor programs include; 

 Easier to use due to automated features such as Word-wrap, autocorrect and auto 

complete 

 They have superior editing tools such as spelling checker, the Thesaurus etc. hence 

making editing easier 

 Can store documents for future retrieval 

 They have superior formatting features that make a document more appealing to the 

reader 

 The user can produce multiple copies more easily 

 Copy and move (cut) operation make it easier to manipulate a document. 

2.5.2 Introduction to Microsoft Word 2010 

2.5.2.1  What is New in Microsoft Word 2010? 

 Microsoft word 2010 is one of the products in the Microsoft office 2010 programs suit. The 

previous versions of Microsoft word include; Microsoft word 97, 2000, XP, 2003 and 2007. 

NB: A program suite is a bundle of different programs packaged and sold as one unit. 
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 Starting Microsoft Word 2010 

 Double click the Microsoft Word 2010 shortcut icon from the desktop 

Or 

 Click on start button from the task bar on the desktop 

 Point at All Programs from the pull up menu 

 Point at Microsoft office from the sidekick menu, then click on Microsoft Word 2010 

from the sidekick menu. 

 

Figure 1: Starting Microsoft Word 2010 

 Microsoft Word 2010 Screen Features 

 Using Microsoft Word 2010 for composing texts is very handy because it has many 

features that make the process quick and rather easy.  

 Below is a screen shot of Microsoft Office 2010; 
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Figure 2: Microsoft Word 2010 Screen Shot 

 Some of the features of the Microsoft Word 2010 are; 

a) The File Button 

 The Office button which was present in the Microsoft Word 2007 is 

called File Button within the Microsoft Word 2010. The File 

Button has the following Save, Save As, Open, Recent, New, 

Print, Save & Send, Help, Options and Exit icons. On the right hand 

side you can view detailed information about the document such as its 

size, number of pages, so on and so forth 

 

 

Figure 3: Microsoft Word 2010 File Button 

b) The Ribbon 

 The Microsoft Word 2010 Ribbon is the place where the toolbar contents are placed. It 

provides a quick and easy access to the most frequently used icons of Microsoft Word 

2010. 

 There are the File, Home, Inset, Page Layout, References, and Mailings, Review and 
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View tabs in the Ribbon on 2010 Word. 

 Each tab has command options organized in units called groups for a better use of the 

Microsoft Office 2010 features. 

 The Home tab has Clipboard, Font, Paragraph, Styles and Editing groups. 

Figure 4: Microsoft Word 2010 Ribbon 

 Insert tab has Pages, Tables, Illustrations, Links, Header and Footer, Text, Symbols 

groups 

 Page Layout Tab houses the Themes, Page Setup, Page Background, Paragraph and 

Arrange groups. 

 References tab houses of Table of Contents, Footnotes, Citations and Bibliography, 

Captions, Index and Table of Authorities and this tab is absolutely perfect for those who 

are working on a research paper, essay, and term paper or similar formal documents. 

 Review, Mailings and View are also other three handy tabs of Microsoft 2010 Word that 

have several groups within themselves and all these are actually available with the 

Microsoft Word 2010 to help you complete your composing tasks easily and quickly. 

c) Quick Access Toolbar 

 Microsoft Word 2010 has Quick Access Toolbar which contains save, undo Repeat 

Typing button and Customize Quick Access drop down list icons. Within the list there 

are New, Open, Save, E-mail, Quick Print, Print Preview and Print, Spelling & Grammar, 

Undo, and Redo, Draw Table, Open Recent File icon. 
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Figure 5: Microsoft Word 2010 Quick Access Toolbar 

d) Document window/Work Area 

 This is the work area where you create your document. It resembles an ordinary piece of 

paper. 

e) Status bar 

 The status bar is the communication point between the user and the application program. 

For example in Microsoft Word, when saving a document the status bar may indicate 

“Word is saving ……”. 

 

Figure 6: Microsoft Word 2010 Status bar 

f) Vertical and Horizontal scroll bars/Arrows 

 Used to view the hidden parts of the document. E.g. one can view text hidden at the top 

of the page by scrolling down and view hidden at the bottom by scrolling down the 

document using the scroll bars or the arrows. 

g) View buttons 

 Used to switch between different document views e.g. normal view. Found on the right of 

the status bar. 

h) Cursor/Insertion pointer 

 Shows where the next character will appear as you type. 

 Creating a New Document 

 A word processor provides the user with a blank screen in which you can enter text or 

pictorial objects such as a pictures and drawings. As you type, the cursor flows 

automatically to the next line when it reaches the right end of the page. This is referred to 

as word wrap. At the end of the page, Word automatically inserts a new page and scrolls 
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up the screen. 

 Saving a Document 

 To save a word processor document follow the procedure below; 

 From the File button, click the Save As command to save the document the first time 

or with a new name (Save command is used when you want to save changes in the 

document) 

 

Figure 7: Save as Dialog Box 

 In the Save As dialog box that appears, select the location (drive/folder) from the 

“Save in” list box 

 Type in the name of the file in the File name box 

 Choose the type of word file to save under the Save as Type e.g. Word Document 

(*.docx), Word 97-2003 document (*.doc) etc. 

 Click the save button or press the Enter key 

 Closing a Document and Exiting the Application 
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 Click on file button 

 Click on Close to close the opened document and leave the application window opened or 

click on Exit to close document and the application window at the same time. 

 Retrieving an Existing Document 

 Click on file button 

 Click on Open from the pull down menu. The open dialog box appears. 

 In the look in box, select the location where the document is saved click on the document 

if seen or browse to locate the document then click on it 

 Click on open command button on the dialog box. The document is opened. 

 Document Views 

 Microsoft word 2010 provides different views for viewing the document that include; 

Print layout, Full screen reading, Web layout, Outline and Draft view 

 To change from one view to another, follow the steps below; 

 Click on view tab 

 Click on the type of view that you want to display 

QS: What are the differences between the different views of the Microsoft word 2010 

document? 

 2.5.2.2 Editing a document 

 Editing refers to the making of necessary changes or modification to an existing document. 

Some editing operations include:  

a) Delete - To delete a character, a word or a block of text: 

 Highlight the text to delete 

 Press the Delete or the backspace key.  
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NB: Delete key erases characters to the right of the cursor while the backspace deletes 

characters to the left of the cursor.  

NB: Use the type over mode to replace characters to the right of text or insert mode to insert 

a character(s) by pushing the rest of the characters to the right. 

b) Redo and Undo 

 Undo is used to reverse changes made in a document while redo reverses the undo changes 

 To undo or redo changes, click either on undo or redo icons from Microsoft Office 2010 

Quick Access toolbar 

c) Moving text 

 Involves relocating text. To move test; 

 Select the text to move 

 Click on Cut icon from the Clipboard group 

 Click on the location to move the text to 

 Click on Paste icon from the Clipboard group 

d) Copying Text 

 Involves duplicating text. To copy text; 

 Select the text to copy 

 Click on Copy icon from Clipboard group 

 Click on the location to copy the text to  

 Click on Paste icon from the Clipboard group 

e) Find and replace 

 This is a feature used to locate for a word or a phrase and replace it with another. To find and 

replace a word or phrase; 

 From home tab, click on Find in the Editing group 
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 The find pane appears on the left which shows the sections of the document where the 

found word/s are. The words automatically found in the document are highlighted  

 To display the Find and Replace dialog box as in the earlier Microsoft word versions, 

click on the drop down triangle next to the find command button, then click on advanced 

find or just click on replace command button 

f) Endnotes and Footnotes 

 Footnotes and endnotes are used in printed documents to explain, comment on, or provide 

references for text in a document. You might use footnotes for detailed comments and 

endnotes for citation of sources. To insert endnotes and footnotes; 

 Highlight the word you want to add an endnote or footnote for 

 Click on the References tab 

 Click on Insert Footnotes or Insert Endnote command button from the footnotes group 

NB: A label appears as a superscript next to the highlighted word and you are prompted 

to type the endnote or the footnote 

 Key in the endnote or footnote where prompted then click on the main document work 

area to continue. 

NB: For more options on footnotes and endnotes as in the earlier Microsoft word 

versions, click on the arrow button on bottom right of the footnotes group to display the 

Footnote and Endnote dialog box and make the appropriate format options e.g. number 

format. 

g) Proof – Reading a Document 

 Proofreading refers to the checking whether a document has typographical and grammar 

errors. Microsoft-word 2010 tools used for proof-reading a document are: Spelling and 

Grammar checker, Thesaurus, auto complete and autocorrect. 
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 Spelling and grammar checker 

 Spelling and grammar checker lets you automatically locate for misspelled words and 

grammatical errors. To spell check a document; 

 Click on the Review tab then click on the Spelling and Grammar command button 

from the Proofing group or press F7. The spelling and Grammar dialog box below 

appears; 

 

 In the displayed dialog box, misspelled words are shown in red while 

grammatically incorrect phrases are in green 

 From the suggestion list, select the correct spelling or grammar. 

 Click on change to correct the word or click on change (All) button to correct all 

instances of the misspelled word. To ignore the error once, click on ignore or 

click the ignore all to ignore every instance of such a word.  

 Thesaurus 

 Thesaurus lets the user to automatically find words or phrases with similar meaning 

(synonym) or opposite meaning (antonym) to the selected. To use thesaurus; 

 Highlight the word to look for its synonym, antonym or meaning 
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 Click on Review button then click on Thesaurus from the proofing group 

 A pane appears on the right showing the synonyms, antonyms or meaning of the 

highlighted word 

2.5.2.3 Formatting a Document 

 Formatting refers to enhancing the appearance of your document. You format text, 

paragraphs, page or the entire document. 

i) Text formatting 

 You format text by applying different font types, style, size, colour and other 

attributes.  

a) Fonts  

 To format text font; 

 Highlight the text to change font 

 Click on Home tab 

 Click on the font option/s to apply from the Font group shown below; 

 

NB: Point at an icon when not sure the option to apply to see a screen tip describing the 

icon pointed. For more Font options as in the earlier Microsoft word versions, click on 

the arrow button on bottom right of the Font group to display the Font dialog box below 

and make the appropriate format options. 
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b) cHANGE cASE 

 The cases applied to text are; lowercase, UPPERCASE, Sentence case, title case 

and tOGGLE cASE. To change case; 

 Highlight the text to change case 

 Click on Home tab then click on the drop down triangle next to the Change case 

icon from the Font group 

 Click on the change case to apply from the drop down list 

c) Superscript and Subscript 

 A superscript appears just above the rest of the characters as in cm
2
 while a 

subscript appears just below other characters as in H2O. To make text superscript 

or subscript; 

 Highlight the character(s) to superscript or subscript 

 Click on Home tab then click on either superscript or subscript icon from the Font 

group 
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ii) Paragraph Formatting 

A paragraph is a separate block of text dealing with a single theme and starting on a new line or 

indent. Some of the formatting features you can apply onto a paragraph include alignment, 

indentation, line spacing, tabs, numbers and bulleting, paragraph border, drop cap etc. To format 

a paragraph; 

 Click on the paragraph or Highlight the paragraph 

 Click on Home tab then click on the alignment option to apply from the paragraph 

group  

NB: Point at an icon when not sure the option to apply to see a screen tip describing the 

icon pointed. For more Paragraph formatting options as in the earlier Microsoft word 

versions, click on the arrow button on bottom right of the Paragraph group to display the 

paragraph dialog box below and make the appropriate format options. 

 

 

2.5.2.4 Page Formatting 

 This involves setting the document layout into columns, page setup, page breaks, column 
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breaks, section breaks, page numbers, header & footer, page background etc. 

a) Inserting columns 

 Columns subdivide a page into several vertical sections. To set columns; 

 Highlight the text or click at the point from where to set the columns 

 Click on Page Layout tab 

 On the page Setup group, click on the drop down triangle under the Columns icon 

 Click on the number of columns to apply or click on More Columns for more options 

b) Page and Column Breaks 

 Page, section and column breaks are used to force the cursor to move from a new page, 

section or column even before the end of the current. To insert a break; 

 Position the insertion pointer where you want to break 

 Click on the insert menu 

 Click Page Layout then click on drop down triangle next to Breaks icon 

 Choose the break type to apply from the drop down list 

c) Page setup 

 Page set up options let you define the paper size, margins and operations. To set up a 

page; 

 Click on Page Layout tab 

 Click on the page setup options to apply from the Page Setup group e.g. Click on 

Margins button to set up page margins, Size button to specify the paper size, 

Orientation button to specify the layout of content on the page etc. 

NB: Point at an icon when not sure the option to apply to see a screen tip describing 
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the icon pointed. For more Paragraph formatting options as in the earlier Microsoft 

word versions, click on the arrow button on bottom right of the Paragraph group to 

display the paragraph dialog box below and make the appropriate format options. 

d) Page Number 

 Page numbers are used to organize a large document for ease of reference. To insert page 

numbers; 

 Click Insert tab then Click on Page Number from the Header & Footer group 

 Choose the position and number format to apply 

e) Header and Footer 

 Headers are lines of text that appears at the top margin of every page or selected pages 

while footers appears at the bottom margin. To insert a header or footer; 

 Click on the Insert tab 

 To insert a Header or a Footer, click on the drop down triangle below the Header or 

Footer command buttons in the Header & Footer group 

 Click on the header or footer type to insert from the drop down list. For more options, 

click on Edit Header or Edit Footer from the drop down list 

2.5.2.5 Microsoft Word Tables 

 A table is made up of rows and columns of cells that you can fill with text and graphics. 

Tables are often used to organize and present information. Columns are the vertical divisions 

while rows a are the horizontal divisions of the table. Intersections between columns and 

rows form cells which are the units for holding data. 

 To create a table in Microsoft Word 2010; 

 Click where you want to create a table then click on the Insert tab 

 On the Table group, click on the drop down triangle below the table Option 
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 Click on Insert Table from the drop down list. The Table dialog box below appears; 

 

 Under Table size, select the number of columns and rows.  

 Under AutoFit behaviour, choose options to adjust table size.  

 To use a built-in table format, click AutoFormat.  

 More table options are on the Table Tools Tab that appears above the ribbon when you click 

inside the inserted table e.g. to insert a row below or above an existing row, click to on the 

row above or below which to insert a new row, click on the Table Tools above the ribbon, 

click on the layout tab, then click on either Insert row below or Insert row above from the 

Rows & Columns group. 
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2.5.2.6 Working with Pictures and Objects in Microsoft Word 2010 

 You can insert a picture object such as a picture, a clip art or drawing on to your document. 

To insert a Picture/object; 

 Click on the Insert Tab then click on Picture button in the Illustrations group  

 Choose the location of the picture/object to insert then click on insert. The picture/object 

is inserted 

NB: The Picture Tools Tab appears above the ribbon when you select the picture 

inserted. This provides more tools for manipulating the picture. Some of the tools 

include crop tool, brightness & contrast settings, shadow effects etc. 

NB: Pictures can also be inserted from the clip art. Equations and Symbols are inserted 

using the tools on the Symbols group. You can also draw and manipulate objects using 

Shapes option in the Illustrations group. 

2.5.2.7 Mail Merge 

 A feature that enables one to create a standard document e.g. form letters to be received by 

many recipients. One can use the Mail Merge Wizard to create form letters, mailing labels, 

envelopes, directories, and mass e-mail and fax distributions. This is done in four basic 

steps: 

a) Open or Create a Main Document  

 Main document: In a mail-merge operation in Word, the document that contains the 

text and graphics that are the same for each version of the merged document, for 

example, the return address or salutation in a form letter. It can be the current 

document you are working on. 

b) Open or Create a Data Source  

 Data source: A file that contains the information to be merged into a document. For 

example, the list of names and addresses you want to use in a mail merge. You can 

create a new one if there none exists. The data source can be from a database in your 
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computer or database server. 

c) Add or customize merge fields  

 Merge Field: A placeholder that you insert in the main document. For example, insert 

the merge field «City» to have Word insert a city name, such as “Nairobi," that's stored in 

the City data field in the main document.  

d) Merge data from the data source into the main document to create a new, merged 

document.  

 You can quickly mail merge using Step by Step Mail Merge wizard in Microsoft 

Word. You can start the step by step mail merge wizard by; 

 Click on Mailings Tab. All tools for creating a mail merge are displayed 

 Click on the drop down triangle below Start mail Merge option in the Start mail 

Merge group 

 From the drop down list, click on Step by Step Mail Merge Wizard. A mail 

merge task pane in displayed on the right with the steps that will enable you to 

mail merge. 

 Exercise: Using mail merge feature in a word processor, write letters to all 

parents/guardians of the students in your school inviting them for a parents’ day. 

2.5.2.8 Protecting a Document Using Passwords 

 To protect a document from unauthorized access or modification, use password. Since 

password is case sensitive, avoid mixed case, preferably use lower case. To create a 

password; 

 Click on File button then click on Save As from the drop down list. You can do this 

when saving the document for the first time or on an already saved document as long 

as one does not change file name 

 Click on the drop down triangle next to Tools option on the bottom left of the Save As 

dialog box shown below; 
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 Click on General Options on the pull up menu 

 Type in a password in the Password to open box and/or the Password to modify box. 

Click Ok to reenter the password/s 

 Click Save from the Save As dialog box.  

2.5.2.9 Printing a Document 

 Word processing is not complete without producing a hardcopy. To print a document, first 

preview it by clicking on the Print Preview and Print icon form the Quick Access Tool. To 

print the document follow the steps below; 

 Click on the File button then click on Print from the pull down menu 

 Set the print options as desired e.g. print range, number of copies and other options 

from the side list.   

 Click on the Print button on the top of the side list. 

NB: Some print problems may occur when you are printing such as; 

 Lack of two-way communication due to poor installation of the printer software 

(drivers), if the printer is off or not connected. Check to ensure that your computer is 

connected and drivers installed in your computer 

 Paper jams due to use of poor quality of paper or paper folds. See technical assistance 
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if unable to remove the papers causing jam 

 Poor quality print due to poor quality ink or toner used. Check and replace the toner 

or cartridge if used up 

2.5.2.10 Application of Electronic Word Processors in Procurement 

 Procurement managers use word processors for generating memos, letters, questionnaires 

etc. 

 Procurement office use Word processors for preparing seminar/workshop  presentations 

 Procurement officers Word processors for creating and compiling procurement reports 


